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Q.No: 1 What population of India is engaged in agricultural activities?
2624295

YR B b S Sy Tiafafal & o g2 82

2
3
A
2
3
1
3
B
1
3
1
4
C
1
4
1
2
D
1
2

Correct Ans : A

Subject : General Knowledge graduate

Q.No: 2 What is a celestial body that revolves around a planet in the same way that a planet revolves around the Sun?
2624351

U @iy s o1 8 Sl U 78 & 9RT &R I Re gHdl & 98 U 98 T & IR 3R g 82
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Moon
A
£l
Satellite
B
EPE
Solar system
C
R Hea
Meteorites
D
Iepiiis

Correct Ans : B

Subject : General Knowledge graduate

Q.No: 3 Who entered the Gupta Empire during the reign of Kumaragupta?
2624719

FARTE & ST B T g § fae yawn faar?

Mangole
A

HMA

Afghans
B

SR

Hunas
C

RUI

All of the given options are incorrect.
D

fau e it fapew Tera &1

Correct Ans : C

Subject : General Knowledge graduate

Q.No: 4  In which of the following journeys will a person have to cross the Tropic of Cancer?
2651236

Fufafea & 3 g amn # fed &) o6 IGT &Y IR BT gNIT?

A Harda to Khandwa

GET IT ON

Google Play
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a1 9§ Waal

Bhopal to Sanchi

B
wure & |t
Khandwa to burhanpur
C
a1 § AR
Balaghat to Mandla
D

qreTge § He

Correct Ans : B

Subject : General Knowledge graduate

Q.No: 5  Which of the following cities of Madhya Pradesh is known as ‘City of Royals'?
2651279

ey vew & fafafad § § forg wer &1 gl &1 WX (Rt it Mae)’ Hgl ol 82

Satna
A

AT

Indore
B

&R

Bhopal
C

wure

Jabalpur
D

SR

Correct Ans : C

Subject : General Knowledge graduate

Q.No: 6  The resolution on Fundamental right and National Economic programme was enacted in which congress session?
2674534

Hiferes SRIPR SR AT 3Mfe HRIGH BT YA S & g SIfYARE & wmm T U1

A Lahore Session,1929
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ARR 3faw, 1929

Karachi Session,1931

B
FI SfRaRHE, 1931
Lucknow Session,1916
C
TS AR, 1916
Kanpur Session, 1925
D

PHYR SHfUARM, 1925
Correct Ans : B

Subject : General Knowledge graduate

Q.No: 7 Which among the following is NOT a bulwark of the constitution?

2674799
frofafed & 9 o dfau™ &1 Wed T 82
Supreme Court
A
SdH AT
Comptroller and Auditor General
B
e e wereran wdiee
Union Public Service Commission
C
Y e qaT TET
Attorney General of India
D

YR BT HEITgard)

Correct Ans : D

Subject : General Knowledge graduate

GET IT ON

Google Play

Q.No: 8  Which of the following was a major port city during medieval India, known for its trade with Southeast Asia and

2680667 (hina?

frafifEd & & H1F-T1 FST YR & SR Tb THW S8 Uex AT, S <féor gd TR &R 1 & 91y 3o IR & o

ST SITdT UT?

A Agra
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STRT

Calicut

CARICad

Goa

Khandwa

dsar
Correct Ans : B

Subject : General Knowledge graduate

Q.No: 9 Which of the following forests is not situated in Tamil Nadu?
2680853

fofafed & @ 19 w1 a7 affeerg 8 fRua 78 82

Kalakad Wildlife Sanctuary

A

PATHS TSI ARG

Indira Gandhi Wildlife Sanctuary
B

gfe midh g=reilg SnaRvg

Bandhavgarh National Park
C

SiYae I IaH

Point Calimere Wildlife Sanctuary
D

WrEe PferAy aUela AR

Correct Ans : C

Subject : General Knowledge graduate

Q.No: 10 Which of the following details are not required to transfer funds through NEFT?
2681626

foffad & § o 91 Ao TEuwd! & A1 I 49 BT YITdH B4 B SHavad Tel 82

A Consumer Id

GET IT ON

Google Play
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I TS ST

IFSC code of beneficiary’s branch

B
WTaddl Pt ET ST IFSC DS
Account number of beneficiary
C
T dl PT @ram Ha
Name of bank of beneficiary
D

UTIddl s BT ATH
Correct Ans : A

Subject : General Knowledge graduate

Q.No: 11 Which of the following tournaments does the team Dabang Mumbai play in?
2683654

3w gan as Fofaied § § S a1 gife § 9ad 82

Indian Premier League

A
gfega MR &
Indian Super League
B
a9 g o
Hockey India League
C
gt §fear o
Pro-Kabaddi League
D

M-Hagt AR
Correct Ans : C

Subject : General Knowledge graduate

Q.No: 12 What was India's rank in the RSF 2022 World Press Freedom Ranking?
2683697

3R.TY. Th. 2022 I8 U IsH IHT H HRT BT b T UT?
136

136
B 142
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142

150

150

156

156

Correct Ans : C

Subject : General Knowledge graduate

GET IT ON

Google Play

Q.No: 13 Which organization recognizes outstanding contributions in the field of mathematics with the Fields Medal?

2684874

D I W69 Bicgd BSd & 1Y IO & &5 & IHT RIGH BT AR <l 872

International Mathematical Union

steeigta wfordta <

American Mathematical Society

ifve AyAfesa wagel

European Mathematical Society

RId Tt wmadt

London Mathematical Society

e TR Srarad

Correct Ans : A

Subject : General Knowledge graduate

Q.No: 14
2685248

How many times was the Preamble of the Constitution amended?

Tfae™ &) gxare § feant IR gxe fear mar?

Three times

d9 R

Two times
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3 IR

Once
C

Th dR

None of the given options
D

e v fawet A & P58
Correct Ans : C

Subject : General Knowledge graduate

Q.No: 15 Sania Mirza has announced her retirement recently. She is related to which sport?
2691652

it el 3 g1 € F Sm I o1 &) 9w 1 21 9% fed T @ g 22

Baseball
A

CECIG)

Chess
B

RICEE |

Cricket
C

fopdpe

Tennis
D

<

Correct Ans : D

Subject : General Knowledge graduate

Q.No: 16 Chanakya was the chief advisor of which ruler ?
2733182

U (69 S & T AGHR A?
Chandragupta Maurya

EEU R
B Kanishka
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GET IT ON

Google Play

At g

Rajyavardhan singh rathore

C
regat g ets
Sikander

D
R

Correct Ans : A

Subject : General Knowledge graduate

Q.No: 17 Which of the following element is used in the process of galvanization?
2733339

Neaitpur 1 ufshar # Fafafad & @ ferg da &1 Iuai fhar orar 82

Sodium
A
Hifsan
Copper
B
PO
Zinc
C
foiw
Tin
D
fea

Correct Ans : C

Subject : General Knowledge graduate

Q.No: 18 Identify the segment in the sentence which contains the grammatical error from the given options.
2621227
It's normal to be scary during an earthquake, which can rock the ground like a boat in rough water.

A It’s normal to be scary
B during an earthquake
C which can rock the

ground like a boat
Correct Ans : A

Subject : General English graduate
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Q.No: 19
2621235

A
B
C
D

GET IT ON

Google Play

Identify the segment in the sentence which contains the grammatical error from the given options.

Once the wettest place on Earth, Cherrapuniji, a town in northeastern India, has face a drought each winter for the

past few years.

Once the wettest place

a town in northeastern India,
has face a drought each winter

for the past few years.

Correct Ans : C

Subject : General English graduate

Q.No: 20
2631498

0O @ >

Select the most appropriate meaning of the given idiom.

Get on one’s nerves
To irritate

To be impatient
To try to copy

To follow aimlessly

Correct Ans : A

Subject : General English graduate

Q.No: 21 Find the most appropriate option for the given blank space which can make the given sentence grammatically and

2648552

A
B
C
D

contextually correct.

The children are always when they get home from school.
anger

freshly

hungry

eagerly

Correct Ans : C

Subject : General English graduate

Q.No: 22
2675209

0O @ >

Select the correct synonym of the given word.

FLAGRANT
blatant
inconspicuous
concealed

unobtrusive

Correct Ans : A

Subject : General English graduate
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Q.No: 23 In the following question, a sentence has been given in Active/Passive Voice. Out of the four alternatives
2675920 suggested, select the one which best expresses the same sentence in Passive/Active Voice.

He rang the temple bell loudly.
A The temple bell was rung loudly by him.
B The temple bell was rang loudly by him.
C The temple bell had been rung loudly by him.
D The temple bell has been rung loudly by him.

Correct Ans : A

Subject : General English graduate

Q.No: 24 In the following question, a sentence has been given in Direct/ Indirect speech. Out of the four alternatives
2676211 suggested, select the one which best expresses the same sentence in Direct/ Indirect speech.

"Politics still interests me, but I avoid discussing it," I said.
I said that politics still interested me, but I avoid discussing it.
I said that politics still interested me, but I avoided discussing it.

I said that politics still interests me, but I avoid discussing it.

o 0O W >

I said that politics still interests me, but I avoided discussing it.
Correct Ans : B

Subject : General English graduate

Q.No: 25 In the following question, a sentence has been given in Direct/ Indirect speech. Out of the four alternatives
2676318 suggested, select the one which best expresses the same sentence in Direct/ Indirect speech.

"He is trying his best to collect the money he needs," said the girl.
A The girl said that he is trying his best to collect the money he needs.
B The girl said that he is trying his best to collect the money he needed.
C The girl said that he was trying his best to collect the money he needed.
D The girl said that he was trying his best to collect the money he had needed.

Correct Ans : C

Subject : General English graduate

Q.No: 26 1In the following question, four words are given, out of which only one word is correctly spelt. Find the correctly
2676527 spelt word.

consceince
scrupuluos

conscientious

o 060 W r

manifesting
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Correct Ans : C

Subject : General English graduate

Q.No: 27 1In the following question, out of the four alternatives, choose the one which can be substituted for the given
2676745 words/sentence.

One that cannot be erased

A connoisseur
B indelible

C heretic

D

Convalescent
Correct Ans : B

Subject : General English graduate

Q.No: 28 In the sentence, identify the segment which contains the grammatical error.
2677409

She was pleased at see them and gave them a grand welcome.

A grand welcome
B gave them a

C at see them

D She was

Correct Ans : C

Subject : General English graduate

Q.No: 29 In the following question, one part of the sentence may or may not have an error. Find out which part of the
2677514 gentence has an error and select the appropriate option. If the sentence is free from error, select 'No Error'.

Articulating your reservations about a proposal is the work of acquainting yourself with your own thoughts.
A Articulating your reservations
B about a proposal is the work
C No error
D of acquainting yourself with your own thoughts.

Correct Ans : C

Subject : General English graduate

Q.No: 30 In the following question a sentence is given in Direct/Indirect speech. Out of the four alternatives choose the one
2686495 \yhich best expresses the same sentence in Indirect/Direct Speech.

He said, “Help! Help!”
A He screamed for me that help.

B He screamed that help help.
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C He shouted for help.
D He has asked for help.

Correct Ans : C

Subject : General English graduate

Q.No: 31 1In the below question, there are five sentences/paragraphs. The sentence/paragraph labelled A is in its correct
2689747 place. The four that follow are labelled B, C, D and E, and need to be arranged in the logical order to form a
coherent paragraph/passage. From the given options, choose the most appropriate option.

A. I had six thousand acres of land, and had thus got much spare land besides the coffee plantation. Part of the
farm was native forest, and about one thousand acres were squatters’ land, what the Kikuyu called their shambas.

B. The squatters’ land was more intensely alive than, the rest of the farm, and was changing with the seasons the
year round. The maize grew up higher than your head as you walked on the narrow hard- trampled footpaths in
between the tall green rustling regiments.

C. The squatters are Natives, who with their families (hold a few acres on a white man’s farm, and in return have
to work for him a certain number of days in the year. My squatters, I think, saw the relationship in a different
light, for many of them were born on the farm, and their fathers before them, and they very likely regarded me as
a sort of superior squatter on their estates.

D. The Kikuyu also grew the sweet potatoes that have a vine like leaf and spread over the ground like a dense
entangled mat, and many varieties of big yellow and green speckled pumpkins.

E. The beans ripened in the fields, were gathered and thrashed by the women, and the maize stalks and coffee
pods were collected and burned, so that in certain seasons thin blue columns of smoke rose here and there all
over the farm.

A CBDE
B CBED
C BCDE
D DBCE

Correct Ans : B

Subject : General English graduate

Q.No: 32 In the following question given below, a sentence is provided with two blanks. Choose the correct combination of
2727921 \yords that fit into the corresponding blanks.

for tests on the immuniser developed in India will serve to the efficacy, safety and
consistency between vaccine batches.

approved, assessing
approval, assess

approval, assessed

o 0O wm >

approved, assess
Correct Ans : B

Subject : General English graduate
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Q.No: 33 Select the most appropriate option to fill in the blank.
2729026

He believed that he had struck terror in his children's hearts because of his

A love

B rage

C calmness
D distress

Correct Ans : B

Subject : General English graduate

Q.No: 34 Select the most appropriate synonym of the given word.

2729243
DELIGHTED
A Coarse
B Unsuited
C Disliked
D Joyful

Correct Ans : D

Subject : General English graduate

Q.No: 35 Which of the following statements about ICMP (Internet Control Message Protocol) might be true?
2635713

ICMP (3¢ eld Ael Hididia) & IR H Fafeiad & I SH-T1 Sy I g Tl 82

It reports all errors which occur during transmission

A
T TR & SR g aret §oft Ffeal it ol swar @
A redirect message is used when a router notices that a packet seems to have been routed wrongly
B
TP HSRRae e T SUNT a4 a1 SI1a1 8 9id U A3 e ol ¢ % ua Gde Tad afid & Fe fFar mn
It informs routers when an incorrect path has been taken
C
A T UM UR I8 3R B JfRd Hal &
The “destination unreachable” type message is used when a router cannot locate the destination
D

"Tiqed 3" (destination
unreachable) UHR T HT 99 IUANT fHUT ATGT & ST I3 Tdad BT UdT 8] o bl &

Correct Ans : B

Subject : General Computer Graduate
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Q.No: 36 BASIC is a computer language, what is its full form?

2635781

BASIC U& HTeR 1T §, S9! guf &0 &1 82

Beginners' All-purpose Symbolists Instruction Code
A

fafir=t srmar-udw Rraifinew seamH ois

Beginner’s All-purpose Symbols Instruction Code
B

Beginner’s All-purpose Symmetry Instruction Code
C

faftrrt sifa-uds RifrdY g @is

Beginner’s All-purpose Symbolic Instruction Code
D

e sifer-udw Risie ser™ ois
Correct Ans : D

Subject : General Computer Graduate

GET IT ON

Google Play

Q.No: 37 FPS is the frequency at which consecutive image/jpgs are captured or displayed. What is its full form?

2635804

FPS 98 Pidal ¢ R IR AR 386 &R $I Sl & 1 UeiRid &1 Sl 81 390! Hahid o1 8?

File Per Second

A
B W A5S
Flow Per Second
B
N W IS
Flops Per Second
C
WY W AH5s
Frames Per Second
D

A R s

Correct Ans : D

Subject : General Computer Graduate

Q.No: 38 Which of the following is not an example of hardware?
2635893
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fFafafad § ¥ SH-T1 FSIWR BT IS0 I8! 872

Scanner

R

Monitor

AR

Printer

fifex

Interpreter

gerfieR
Correct Ans : D

Subject : General Computer Graduate

Q.No: 39 Which is the menu to create a text box on a slide?
2636077

WES R TRE o -1 & U Bg HI9-T1 32

View -> Text Box

A
o -> TRE I
Insert -> Text Box
B
¢ -> TRT g
Format -> Text Box
C
BiHe -> TRE qIN
Tools -> Text Box
D

TR -> TR AR
Correct Ans : B

Subject : General Computer Graduate

Q.No: 40 What is the purpose of data loss prevention (DLP) software in computer security?
2636947


https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Addai247

e Fref H o7 Ay A=A (DLP) WitedR &1 L= M 32

To prevent the loss or theft of sensitive information

A
HagTeie AR & JHA a1 9 F AP F g
To protect against malware
B
IR | F91@ F g
To encrypt data
C
Se1 TRpE #3 & frg
To prevent data breaches
D

32T YAl (breaches) &I Jd & forg

Correct Ans : A

Subject : General Computer Graduate

Q.No: 41  Which of the following operating systems doesn't have a firm owning and licensing it?

2638929
Frafefed 3 3 e sfftrfen Ren & U9 B1% BH 31 ¢ SR 39T armed el 82
Windows
A
fists
Mac
B
%
Unix
C
g
None of the given options
D

fau T fawent A A #I1S TE
Correct Ans : C

Subject : General Computer Graduate

Q.No: 42 The internet service that provides 'audio’' and 'video' conversations is called:
2645145

FeC DI 98 AT B, Sl '3ifea ud dIfSA) ardaiag UeH $dl 8, Hedrdl &
A Chat

GET IT ON

Google Play
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£
E-mail
B
3-Ad
Video Conferencing
C
fifSar SipRAT
Voice Call
D

g B
Correct Ans : C

Subject : General Computer Graduate

Q.No: 43 Who out of the following introduced the concept of stored-program computers which was capable of storing data
2675298 55 well as programs in the memory?

frafafad & 9 frem WEa-Umm (RR-UUTH) $WER S SaUR0T U $I o ST & I1Y-91 FER & TR &1 T8 (RR)
HA T e ur?

Alan Turing

A
T i
Herman Hollerith
B
T BNy
John Von Neumann
(o
ST a1 gAe
Blaise Pascal
D

= U
Correct Ans : C

Subject : General Computer Graduate

Q.No: 44 In which of the following services do users need to log in to a server computer remotely, and then to log out again
2675314 \\hen the user finishes accessing information on the server computer?
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GET IT ON

Google Play

frofafad § 9 fg Jar & Suarsdisll & QX 0 F IR HR T Al 37 TR B ATl gidt ¢, AR B od Judirasar

TR YR R DR TR BT AT PR AdT € dl R J AT 313 HRAT ISl 82

NetScape
A

Jeby

Mozilla
B

Hifsren

FTP
(o

THdt

MacWeb
D

Apad

Correct Ans : C

Subject : General Computer Graduate

Q.No: 45 Which technique is used to hide the information in a picture?

2675671
forddt e o gEenoft &1 fsum & for fovw aofies &1 v fora Sirar g2
Cryptography
A
lEgabiidl
Forensics
B
BRR®
Steganography
C
wawt
Image rendering
D

Bfa ufaure
Correct Ans : C

Subject : General Computer Graduate

Q.No: 46 What is the purpose of BIOS shadow?
2678186
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GET IT ON

Google Play

ST SR BT I R 22

Copying RAM to ROM

A
| P A9 | S BT
Coping ROM to RAM

B
A9 P YA G PIG A
Copying HD to RAM

C
TSP oY ¥ § HIdt ST
Copying RAM to HD

D

I P grefevd A Bt S0
Correct Ans : B

Subject : General Computer Graduate

Q.No: 47 Which one of the following is a text function in MS Excel?

2678256
g & ¥ o9 91 THey TR | T TRe HhavH g2
MID()
A
MID()
NOW()
B
NOW()
COUNT()
C
COUNT()
SIGN()
D
SIGN()

Correct Ans : A

Subject : General Computer Graduate

Q.No: 48 Which modern technology is used by the majority of grocery retailers to enter the product code?
2680420

IAE HIS &St B P oY ATRIBTT =TT et fatharelt gRT fb oy adb-ites o1 SUTNT fbar Sirar g2

A Interface/Pick Devices
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b / U fEargw
Touch Screens
B
T BhH
Light Pens
C
GIECRE
Scanning devices
D

Wi fEasy
Correct Ans : D

Subject : General Computer Graduate

Q.No: 49 What type of input device does video game use?

2680421
difga 1 5T UbR & 37Yc a3y BT IUINT el 872
Joystick
A
Srafes
Digitising tablet
B
fSRrersfom eaae
Trackball
C
Tara
Mouse
D
|39

Correct Ans : A

Subject : General Computer Graduate

Q.No: 50 Which of the following is an output device?
2684603

fofafed & & H1F-11 T 313eye feargy 82

A Printer

GET IT ON

Google Play
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fliex

Monitor
B

AeR

Mouse
C

A3

Printer and Monitor both
D

fiiex aiv Hifrew At

Correct Ans : D

Subject : General Computer Graduate

Q.No: 51 Select the option that is related to the figure in the same way that the second figure is related to the first figure.

2629421
@- e . ?
39 facbed &1 I B ol A el A I oRg Weifid & S gad 3pfy U Sl I Waifera B
it el

A

B w
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LK
h
h
d-
d-

Correct Ans : A

Subject : General Aptitude Graduate

Sione If (2x + 3y + 4z) = 0, find the value of (8x3 +27y? + 642).

I (2x+ 3y +42)=0 T al, (8x3 +27y3 + 642%) FT AT AT HL-

42xyz
A

42xyz

72xyz
B

72xyz
c 36

xyz
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36

xyz

32

xyz

32

Xyz

Correct Ans : B

Subject : General Aptitude Graduate

Q.No: 53 In the following question, select a figure from amongst the four alternatives, which when placed in the blank
2642164 space of figure (X) would complete the pattern. Identify the figure that completes the pattern.

Fraferd uy &, TR 3nepfa & A Uh 3Pl $1 =g B, R S Mepfa & Tl & (X) & 1 &1 8, df Ued 31 ghn 81
3 3MPTA F) TaH ot Yo & T Bl 8
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i/

© LU MV

Correct Ans : C

Subject : General Aptitude Graduate

Q.No: 54 Eight friends J, K, L, M, N, O, P and Q are sitting around a circle facing the centre. J is not the neighbour of N. L is
2663907 thijrd to the right of K. Q is second to the left of N who is next to the right of L. O is not the neighbour of N or K
and is to the immediate left of P.

Which of the following is the correct position of L?

33 7 3, K, L, M, N, O, P 3R Q &g BT 3R T & Udh g & dIRI AR I3 €11, N &1 TSRl 761 81 L, K & e ¥ TRy g
QNF IV I TR V/YAWE, ol L & g I AT 81 0, N T K FHT TSR g § 3R ISP 31d a1 P 5l

fFrafafed & @ L 3t 931 fRufd o @ 82

To the immediate right of N

N ¥ 3@ i

To the immediate right of Q

Q ¥ dl®

To the immediate left of L
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L & 3l I

To the immediate left of Q

QF Hwr a2
Correct Ans : B

Subject : General Aptitude Graduate

Q.No: 55 In the following question select the odd word pair from the given alternatives.

2665138
f=fafed o= o fou U faseul & & favd e g™ &1 997 He
Desert: sand
A
e |
Grassland: grass
B
U P AGH: 9T
River: water
C
T4 urt
Forest: Jungle
D

q: ST
Correct Ans : D

Subject : General Aptitude Graduate

Q.No: 56 Which set of letters when sequentially placed at the gaps in the given letter series shall complete it?
2665168

ab__a_c_a

IH N U q & TS 3ieR Faar H Rad VM R [ TH W 4R BT HIH-T1 TE 58 T HI?

ab__a_c_a

cbdab

cbdab
cdbbd

cdbbd
C cdddd
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cdddd
cdbdb

cdbdb

Correct Ans : D

Subject : General Aptitude Graduate

Q.No: 57 Two pipes X and Y can fill an empty tank in 16 hours and 20 hours respectively. Pipe Z alone can empty the
2670464 completely filled tank in 25 hours. Firstly both pipes X and Y are opened and after 6 hours pipe Z is also opened.
What will be the total time (in hours) taken to completely fill the tank?

3 A X 3R Y U Wiell Tt BT HRE: 16 S 3R 20 9 H WR Iabvd 1 T Z 3fhdl guid: U g3 <! HI 25 He § Wrelt &
THdT 81 U8A X 3R Y S 9d Wit 1 € 3IR 6 9 & a1g Id Z | ol g1 <t & guid: 1R & forg foran o ot g
(°c ®) 1 gnmm?

80/7

80/7
67/7

67/7
28/3

28/3
304/29

304/29
Correct Ans : D

Subject : General Aptitude Graduate

Q.No: 58 If in 3 years at simple interest the principal increases by 18%, what will be the compound interest (in Rs.) earned
2673183 (5 Rs.25,000 in 3 years at the same rate?

g 3 auf A YIYRY A R AT 18% F §¢ ol §, @ 391 & W 3 T1d H 25,000 . W 3ifid Iqfg < (3. H) F1 g2

4775.4

4775.4
B 5774.5
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5774.5

4557.4
C

4557.4

5575.4
D

5575.4

Correct Ans : A

Subject : General Aptitude Graduate

Q.No: 59 Directions: Four statements and Three conclusions are given in this question. Read the statements carefully and
2679763 nderstand which of the conclusions are correct by logically.

Statements:

Some red are blue.

All white are blue.

All yellow are red.

Some white are orange.
Conclusions:

I. Some white are yellow.

II. Some orange are definitely red.

III. At least some blue are orange.

= 39 Uy & IR FF SR fF e fau MU § 1 e B e 9§ ue oIk whe i B 9 ey aifde FU 9 w8
FY:

FS ard A1d g1

Wit g A &

it fidt a1t g1

TS g A 5

e

1. $F e Ui §1

I1. $& T fAf¥d w0 @ @ g

I11. HH I $H & 1 TR0

both conclusions I and III follow

Y s 18R 11T SFERor B &

B only conclusion III follow
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Fae freed 111 SERr Bar @
both conclusions I and II follow
C
3 s 1 SR 1T S gERYT R &
both conclusions II and III follow
D

3 s 11 SR IIT SRR #3d &

Correct Ans : B

Subject : General Aptitude Graduate

GET IT ON

Google Play

Q.No: 60 A shopkeeper sells 90 litres of mustard oil in Rs.8730 at the profit of Rs.12 per litre of mustard oil. What is the

2695621 (gt price of 1 litre of mustard oil?

% gHMER 8730 IUU & 90 THex WA &I dd, 12 THex WA & ddl & A1H W o=dl gl 1 diex Wl & I BT 56d Jed &1 g2

Rs.90
A

90 I

Rs.95
B

95 I

Rs.80
C

80 W

Rs.85
D

85 I

Correct Ans : D

Subject : General Aptitude Graduate

Q.No: 61 Which number will replace the question mark (?) in the following series?
2698519

5,8, 20, 34, 76, 142, ?

fufafad saar & uy forg (2) & /M R 19 I Te smwf?

5,8, 20, 34, 76, 142, ?
A 272
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272

296

296

284

284
302

302

Correct Ans : B

Subject : General Aptitude Graduate

Q.No: 62 From the given alternatives, select the word which cannot be formed using the letters given in the word.
2698586
INTERNATIONAL

{3 gu fasbedl § U 39 Wea &1 AT ot il 13T 7T e H =MA 3{&RT I & 5t Jobell Bl
INTERNATIONAL

TERMINAL
TERMINAL

RATIONALE

RATIONALE

INTERNAL
INTERNAL

LANTERN

LANTERN

Correct Ans : A

Subject : General Aptitude Graduate

Q.No: 63 Find the figure from the answer figure that will replace the question mark (?) from the problem figure.
2755671

Question Figure:

.n:m“trﬁ.:

=

FIWR AP Y T8 P J1d DI Sl THET HHId J Uarasd fog (?) &I ufaafd &R ¢
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R ATPIa:

®
]
K
-
>
-~

A\
A\
A
A
A
A
A
A

Correct Ans : D

Subject : General Aptitude Graduate

Q.No: 64 Find the figure from the answer figure that will replace the question mark (?) from the problem figure.
2755691

Question Figure:

NINIE
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JWR AP Y T8 AP J1d DI S THRT P F TarEd g (?) B Ufaifid &R g1
e AT

NINISE

®
®
®
®
©
@),
*)

S

Correct Ans : C

Subject : General Aptitude Graduate

GET IT ON

Google Play

Q.No: 65 1In a certain code if 'M' denotes'+', 'N' denotes 'x', 'O' denotes '+' and 'P' denotes '-', then what will be the value

2755716 f 16M4N305P3M3?

e ue FAfyd drs W & '™y, ' B SR g, N, 'x' H S=AAr 8, 0", '+ Pl guiar g 3R P,
'~ Pl g , A 16MAN305P3M3 &1 A =T gIm?

A 14
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14

15

15

16

16

17

17

Correct Ans : C

Subject : General Aptitude Graduate

Q.No: 66 Three positions of a cube are shown below. Which numbers will come on two faces marked ‘A’ and ‘B’ in the fourth

2755730 position?

g oo Jo

e o9 31 7 Rufag 9 axifs 7 g1 o & o Al Rfa § A7 @ik 87 & wu § RIfRd & was! gitft?

ploJANa

(4, 2)

(4, 2)
(5, 2)

(5, 2)
(6, 5)

(6, 5)
(6, 2)

(6, 2)
Correct Ans : C

Subject : General Aptitude Graduate
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Q.No: 67 At three distinct road crossings, the traffic lights change after 15, 3, and 45 seconds, respectively. What time will
2617093 they all change at once again if they all change simultaneously at 11:45:25 AM?

T 3rerT-3eT TS ARTE! W, e AlSe HHRE: 15, 3 3R 45 J638 & d1¢ 95d o g1 afe 3 Tt 11:45:25 galg W &
Y sl 8, o 3 9 T IR R foban oo Seai?

11:45:55 AM
A

11:45:55 AM

11:46:55 AM
B

11:46:55 AM

11:46:25 AM
C

11:46:25 AM

None of the given options
D

fou U faeat A A+ TS
Correct Ans : B

Subject : General Maths graduate

Q.No: 68 A and B earn in the ratio of 8:9. They spend in the ratio of 5:7 and their savings is in the ratio of 9:7. If their total
2629615 monthly expenditure is Rs. 8400, then the annual salary of B is?

AT B 8:9 F U H HAM &1 d 5:7 & U B IR G § au1 9:7 F U H §99d H=d ¢ | Al I%T $dl ARG
IR 8400 =TT g, dl B HI alftids da fora g2

Rs. 84672
A

84672 ¥UU

Rs. 77526
B

77526 ¥UU¢

Rs. 80154
C

80154 ¥UU

Rs. 75256
D

75256 ¥UU¢

Correct Ans : A

Subject : General Maths graduate


https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Addai247 Eooale Play

Q.No: 69 The average marks of 45 students was found to be 66. If the marks of two students were incorrectly entered as
2643172 33 and 64 instead of 82 and 46 respectively, then what is the correct average?

45 faenffat & Sigd siw 66 UTT MU
gfe ot faenffal & i 82 3R 46 F WM W el ¥ HHA: 28 3R 64 forg 7 &, df Wet i w1 gm?

67.2

67.2

66.8

66.8

66.4

66.4

66.6

66.6
Correct Ans : B

Subject : General Maths graduate

Q.No: 70 The LCM of two numbers is 15 times their HCF. The sum of LCM and HCF is 960. If one of the nhumber is 180, then
2645758 the other is:
3 =Sl BT A9, IAb U9, BT 15 1 8| T.9. R T.9. HT I 960 §1 Al T T 180 7, dl g T3 8

S
= S0
© a0
> 3

Correct Ans : B

Subject : General Maths graduate

Q.No: 71 gimplify: 4-(2 x 10) x 0
2667138 plify: 4-( )

T BT 4-(2 % 10) * 0

A 3
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0

Correct Ans : B

Subject : General Maths graduate

Q.No: 72 Simplify-
2667329

8x 76 -38x ?7—-50 _ 30
?x 7 x 12 +3- 32 108

WA Pifore-

8x 76 -38x ?7—-50 _ 30
?x 7 x 12 +3-— 32 108

4
A

4

5
B

5

8
C

8

6
D

6

Correct Ans : B

Subject : General Maths graduate
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Q.No: 73 The average of the test scores of a class of ‘m’ students is 70 and that of ‘n’ students is 91. When the scores of
2672456 poth the classes are combined, the average is 80. What is m:n?

'‘m’ BT &I Th BT & U & 3l BT 3Md 70 § TUT 'n’ BT DI BT &b b BT A 91 81 G Heffl & il Bl oiig W
3d 80 I BIT &1 m:n &1 2

10/13
A

10/13

10/11
B

10/11

11/10
C

11/10

13/10
D

13/10

Correct Ans : C

Subject : General Maths graduate

3'6'\1702:6?446 If polynomial x* + x° + 8x° + ax + b.is fully divisible by x> + 1, then find the value of a and b.
T SgIE x* + x° + 82 + ax + b, x* + 1 ¥ uia: fauifera g, @ "a’ 3T ‘b’ &1 AF F1d Siferd|
a=1,b=7

A
a=1,b=7
a=2,b=5

B
a=2,b=5
a=2,b=7

C
a=2,b=7
None of the given option

D

o ¢ fawent A @ #1$ TE
Correct Ans : A

Subject : General Maths graduate
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Q.No: 75 The ratio of speed of A and Bis 4 : 5 and A loses the race by 200m, then what is the length of the race course?

2672911
A 3R B &I 7Ifd BT 3UId 4: 5 8 3R A, 200 Hiex ¥ <18 §R T 8, Y &I P! @Ts foba-T 82
1000m
A
1000 #
3000m
B
30007t
4000m
C
4000 #t
5000m
D
5000 #Ht

Correct Ans : A

Subject : General Maths graduate

Q.No: 76 4 and B together can finish a work in 36 davs. A and G 1ake Tf_x days more to complets the same work

2673059 4 anthatof Band C. 4B i C Rtk dBple@ihe worlth: 14 damsatl h SUEE days #1 Al B and
C finish it separately?
A3 BfA#ET 36 ol # U 1A qU & Tohd &1 AR CH AdH F1A F= 7 B AR
C EaRT U TR FH F B e A 7> T afie e €1 A BAR ¢ Awe 24 R A
HE O A 81 A B AR CF 59 Feaw A & oo wem
60,72,90
A
60,72,90
60,90,72
B
60,90,72
72,60,90
C
72,60,90

D 90,60,72
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90,60,72
Correct Ans : D

Subject : General Maths graduate

Q.No: 77 There is sufficient food for 2400 soldiers for 60 days and each soldier eats 750 grams every day after 43 days
2673089 900 soldiers left the camp. Now for how many days rest of the food lasted for the rest of the soldiers if each ate
850gram food every day.

2400 IfHT F oW 60 o= & T yai HivH g 3R ude e ufafem 750 I v Trar ® 43 fef & a1 900 IfeT
P fUfR | 916 Npd W1d B1 319 a1ep! SIa! & forg Wi foedm fat o 3gar 21 afe o ufafes &¥e AR 850 UH W T WUl

18
A

18

28
B

28

24
C

24

32
D

32

Correct Ans : C

Subject : General Maths graduate

Q.No: 78  ABCD is a thombus and £ ABC = 72°, then what is the measure of 2CAD?

2674500
T FAGGHS ABCD 3R £LABC=72%. @ £CAD &1 A v gam?
62°
A
62°
54°
B
54°

c 58°
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58°

52

52

Correct Ans : B

Subject : General Maths graduate

Q.No: 79 12 men, 10 women and 28 children complete a work in 120 days and 6 women, 6 men and 14 children complete
2675174 the same work in 60 days. In how many days will 5 women together complete the whole work?

12 J3Y, 10 AidT 3R 28 5= TP &1 I 120 oAl & Q1 & § a7 6 AR, 6 T¥Y 3R 14 5= §0H S &1 60 &A1 & g
A g1 5 ARGAE TP Ty Tyul B Y fve et o g1 it

12 days
A

12 fa=

16 days
B

16 fa

14 days
C

14 a7

18 days
D

18 fa=

Correct Ans : B

Subject : General Maths graduate

Q.No: 80 Find the LCM of 0.6, 1.8, 0. 36.

2680161
0.6, 1.8, 0.36 &1 @.9. J1d BHifo|
3.6
A
3.6
1.8
B

1.8
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7.2
C

7.2

10.8
D

10.8

Correct Ans : B

Subject : General Maths graduate

Q.No: 81 A shopkeeper gives three successive discounts of 10%, 15% and 25% to his customer on marked price of a
2681525 product. To his another customer he gives 10%, 20% and 20% discounts on the same product. If the difference
between the purchasing prices of two customers is Rs.540, then what is the marked price of each product?

% gHFER U IAG $I IR ST W U TEH B 10%, 15% 3R 25% HI TMAR Fe ol g
3T G UEH Bl a8 U I W 10%, 20% 3R 20% 1 Je &l ¢
e 1 UEHh! S U Ged & s BT 3R 3.540 B, Al TP Iadie- o1 R P1ud 3 82

Rs.215000
A

¥$.215000

Rs.228000
B

%$.228000

Rs.240000
C

%.240000

Rs.232000
D

%.232000

Correct Ans : C

Subject : General Maths graduate

Q.No: 82 A Man travelled a certain distance by car. One-third of distance travelled at 60 km/hr. Two third of remaining
2688012 rayelled at 50 km/hr and the rest at 70 km/hr. Find the average speed of the car.

Td 3MTeH HR F T Ffd g8t 70 o1 81 U fwTE & 60 fell/sier ot fa & a7 ot 711 A o1 <) fagrs 50 ey
HeT Bt Tfa F 3R AW 75 fHHt/Her 31 7fd I 51 a1 g1 BR B 3G T J1d P

50 kmph

50 feH ufa ger

B 48 kmph
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48 et ufa ger
62 kmph

C
62 Tt ufar ger
52 kmph

D
52 et ufa ger

Correct Ans : A

Subject : General Maths graduate

Q.No: 83 Four friends A, B, C and D rented a bungalow and promised to share the rent as follows:
2696132
A:B=8:15B:C=5:8,C:D=4:5. What part of the rent C will pay?

IR GRAT A, B, C 3R D 3 T S77al fohvTu IR foran 3R fmd &l 39 TR I = HT el fparfs A: B=8:15B:C=5
:8,C:D=4:5 g C® W &1 femn s gme

24
77
24
77
23
77
Z3
77
25
77
25
77
26
77
26
77
Correct Ans : A

Subject : General Maths graduate

26'1%18141 PRI § § $H-91 Teg Ty THR BT T8 ISR 87
A AR

B TTHST

C kg

D EEkCEd

Correct Ans : A
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Subject : General Hindi graduate

Q:No: 85 e wiea-Twgl # ¥ BH-1 Rideu w6 Uedl &1 We) IaTeR0 27

2660245

A =R, qRefteR, Bres
B daleR, Udd, ST

C Td, $d, W

D JEISTaY, 3d%, STHUR

Correct Ans : C

Subject : General Hindi graduate

Q.No: 86 mﬁ@m_g}q“a{ﬁ_ 3 7 & gt o Vg &1 T PIfoTE-

2660470

A Aqdd/ Y- 4/ Haad
B 3T - Age

C 3 — ATl

D AT - A

Correct Ans : A

Subject : General Hindi graduate

Q.No: 87 wGyait o1 uopare Wi e F @ 1 ENTIR

2660708
A ORI
B it
C R
D SR

Correct Ans : B

Subject : General Hindi graduate

Q.No: 88 ' o 3 Rreranfeelues evalud ol &1 9a7 Fe-

2660891
A -1, Y-t fis-fs e R
B AT Ga!

C T4 TN S§! IB! Afe-e

D 3fgT! drg! dig-dle

Correct Ans : D

Subject : General Hindi graduate

Q.No: 89 Arefof@a & a»—cjam gdgu-
2661176 iR P

A STTS FRT T TR 4|
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B IM A b1 BT Iy faviiwer =1 T feam
C i | id Tl IgT S|
D g Idr el Srani

Correct Ans : B

Subject : General Hindi graduate

Q:No: 90 - ffifa # ¥ -1 a1, Fiare B IATERV A B2

2661203

A T4l @I 3™ feam

B HIg RT UeT o 367 ¢

C YRAATRIG! §RT WETT Tieht 781 YT o gHhd |
D <hear gRT v foran = e B

Correct Ans : A

Subject : General Hindi graduate

QNO: O ot 0= afeq vt & el @ 1=y B Y wwTe &), el R B A b e 1w sifard € o @2

2661246

A o g

B u=Aara® fag

C fawmfeaiys s
D JrsfaRm faeg

Correct Ans : D

Subject : General Hindi graduate

Q.No: 92 ffafRad A & Ui Hy= AT MU §1 3% 39 IRE HHaS T f I Ue 3rfyef ufkede 59 o, R 39 a1e 3w
2661427 fygmedi A ¥ Wel fadwey &1 997 Fifvm

A. Tt oft W7 & <Ieg AR W & 7 ¥ g1 o1 &1 I & &1l &
B. f=t wror & gf® & woa uerdf ot

C. 3(d: ol Trea) T fofiT FeRu TRear I g1 9T &,

D. &1 g o1 & favaa fopam mam &1

E. Qfdp1 fisifa wreal o1 ot FaRRor = &fa= giam g1

A ABDCE
B BDACE
C EDABC

CDBAE

Correct Ans : A

Subject : General Hindi graduate

Q.NO: 93 n Y ¥
5666427 HT 9gd ot credl ¢ I° 39 I § faRior & 2
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A
B
C
D
Correct Ans : C

Subject : General Hindi graduate

Q.No: 94 pyfafRg B F aewR” &1 AT W @1 32

2666494
A 3gH

B AT
C ]|
D U

Correct Ans : C

Subject : General Hindi graduate

QNO: 95 ot & § o YoTel ¥ FE IRV T T5F Hifoe-

2666796

A gfe quf st ghit &Y wara oft ardt gt
B Hg=T g o & AT

C B 3w @1 Yol §

D TrYq § f5 95 @a saw Wl

Correct Ans : C

Subject : General Hindi graduate

QNo: 96 frarfesive ar "o €1 gH GE 31, TGS FraTTe ar e & 3 g g

2666928
A 3§ g 31 TU!

B TP TR ATTHA A U FW 2
C 3ig, 9 TE1 e A

D i, gH a1 3T &

Correct Ans : B

Subject : General Hindi graduate

ST o PR 3 ¥ s IR A gww @1
A wed

B 3

C q

D 3

Correct Ans : D

GET IT ON
Google Play
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Subject : General Hindi graduate

QMo: 98 fwifeed & & ‘3o Hiet & off %81 &' - § g "SI’ Fud BT TR FRe-

2668138

A STGREAD
B frmmafeatas
C SAYURUEYD
D CNCEEY

Correct Ans : D

Subject : General Hindi graduate

Q.No: 99 AR U= & g HuF U U B 1 3% 39 dRE HHS I 5 379 T orefuul uRede a7 wmg, fmR 39 a1g i e
2668488 fygmeul O A Wl fadey &1 9o Pl
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E o1 UsR
A ABDCE
B BDACE
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Correct Ans : C

Subject : General Hindi graduate
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B SIYHT
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D GELH

Correct Ans : B

Subject : General Hindi graduate
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